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Océ TDS300

User Manual
Chapter 1
Introduction

This chapter describes the main features, the options and 
the software applications provided with the Océ TDS300 
system.
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The Océ TDS300

The Océ TDS300 is a wide format, black and white, multifunctional system. 
The Océ TDS300 offers a range of print and copy functionality. The system 
includes a printer (1 or 2 rolls) a controller and an optional scanner. 

[1] Océ TDS300
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The Océ TDS300 concept and components

The Océ TDS300 printer

The Océ TDS300 printer is available with an automatic 1- or 2-roll unit and 
manual feed. Use manual feed when you want to print a job on a media type or 
size that is not available on one of the paper rolls. 

Note: The manual feed is a special slot just above the paper drawers on the 
printer. You can insert cut sheet material in this slot, one sheet at a time.Refer 
to ‘Copy on pre-cut sheets’ on page 49 on how to copy on pre-cut sheets.

Note: Only use material as specified in ‘List of available material types and 
sizes’ on page 109.

The Océ TDS300 printer is a LED printer with a resolution of 600 DPI and a 
printing speed of 1.8 A0 or 3 meters per minute. 

You can perform a number of activities at the Océ TDS300 printer. You can set 
the media type and size, stop a print job or select your preferred language from 
the printer operator panel (see chapter 2, ‘Use the Océ TDS300 to print’ on 
page 19 for more details). 

The Océ TDS300 is delivered with drivers to enable you to print from 
AutoCAD®, Windows® or Macintosh® applications.

The Océ TDS300 scanner

The Océ TDS300 scanner supports a wide range of copy activities. It provides 
a large number of functions for defining original and copy related settings. You 
can specify particular media, feeding and quality enhancement options from 
the scanner operator panel. In combination with the Océ TDS300 printer it 
forms a powerful productivity tool. 

The scanner has different quality modes which are provided by Océ Image 
Logic®.

■ Green key principle
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The Océ TDS300 is easy to use. Press the green key on the scanner operator 
panel to start the basic copy jobs. If you have difficult copy jobs, you change 
the default copy settings with the help of the other settings on the scanner 
operator panel.

The Océ Power Logic® controller

The Océ TDS300 is equipped with a controller to process the print jobs and the 
copy jobs. With Océ Remote Logic® you can connect to the controller to define 
the default settings for the system.

The Océ Power Logic® controller  processes the print jobs and the copy jobs.

■ Spool memory
The Océ TDS300 has a spool memory which provides a queuing system for 
files you want to print. The spool memory allows many users to send the print 
jobs to the Océ TDS300 at the same time. The print jobs are put in the print 
queue where they wait to be printed. The job that is put first into the queue is 
printed first.

■ Network connectivity
The Océ TDS300 controls a number of common network protocols. The Océ 
TDS300 can be used in many networks like TCP/IP and Novell®.

Océ Remote Logic®  enables you to connect to the Océ Power Logic® 
Controller from a remote workstation.

Océ Settings Editor  The Océ Settings Editor allows you to set the default 
settings of the Océ TDS300 according to your companies requirements.

Refer to ‘Océ Power Logic®: The Settings Editor’ on page 67, for complete 
information about the Océ Settings Editor application.

Océ TDS300 options

By default, the Océ TDS300 has an automatic 1 roll unit and is equipped with 
a receiving tray as the output delivery device. The receiving tray is the rack on 
the bottom of the printer (see figure 1 on page 12).

Automatic 2-roll unit  The Océ TDS300 is available with an automatic 2-roll 
unit. Each of the rolls can be loaded with print material of a different size or 
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type. The size and type of the available media are indicated on the operating 
panel.

Adobe® PostScript® 3/PDF  The Océ TDS300 fully supports Adobe® 
PostScript® 3 for all supported languages. 

Océ Print ExecTM LT  Océ Print ExecTM LT is optional software to create and 
submit your print jobs.
Introduction 11



Océ TDS300 users

The Océ TDS300 has the following user types:

System administrator  The Océ TDS300 system administrator installs and 
makes the configuration for Océ TDS300. The system administrator defines 
the printer-language settings, pen settings and Automatic Language Sensing 
(ALS) settings. The system administrator can help the users who need to install 
the printer drivers on their workstations. See chapter 6, ‘Printer supplies and 
maintenance’ on page 87 for complete information. The configuration 
information is in the Océ TDS300 Connectivity Manual provided with the Océ 
TDS300.

Key operator  The Océ TDS300 key operator is responsible for the daily 
maintenance of the Océ TDS300. The key operator replenishes toner when 
necessary, loads media as needed and defines the default printer settings for 
recurring print jobs. Also, the key operator defines all time settings, such as 
panel time out and sleep mode time out. See ‘Océ Power Logic®: The Settings 
Editor’ on page 67 for more information. 

Repro operator  The repro operator is responsible for the daily operations on 
the Océ TDS300. The Repro Operator has no rights to change settings in the Océ 
Settings Editor.

Anonymous user  Typically, an anonymous user on the Océ TDS300 can be 
either a PC user who has remote access to the system through one or more 
drivers (Windows® driver, AutoCAD® HDI or PostScript®), through Océ 
Remote Logic®, or through job submission applications. It can also be a user 
performing a copy job at the scanner.

User interaction

You can operate the Océ TDS300 from different locations: local and remote:
■ Operator panels

The Océ TDS300 has two operator panels to make the settings for the print 
jobs and the copy jobs. See ‘Printer operator panel’ on page 20 and ‘Scanner 
operator panel’ on page 38 for complete information.
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■ Océ Remote Logic®

Use the Océ Remote Logic® to make the default key operator and system 
administrator settings (Océ Settings Editor). 

■ Printer drivers
With the Océ TDS300 one or more printer drivers can be used, including, 
Windows® raster driver for Microsoft Windows® 95/98, Windows® printer 
driver for Microsoft Windows® 2000® XP, and NT 4.0®, AutoCAD® HDI 
driver and Adobe® PostScript® 3TM driver. With this software PC users can 
access the Océ TDS300 remotely from their applications, to print their files. 
More information about installing, configuring and use of the drivers can be 
found in the documentation provided with the drivers. All Océ drivers 
(except Postscript) can be freely downloaded from the Web at www.oce.com.
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The data flow to the Océ TDS300

Connect the Océ TDS300 to a workstation connected to a network. It accepts 
different standard format vector and raster data files from the host environment 
and converts these into high quality prints (see figure 2).

[2] Data flow to the Océ TDS300

When an Océ TDS300 receives vector, raster, Adobe® PostScript® or PDF 
(optional, Adobe® PostScript® 3™) data it will generate a print with the 
settings as specified in the Océ Settings Editor.

Each print job has remote control commands to indicate the settings for a job. 
This so called header contains the job and the file defined settings in Océ Job 
Ticket (OJT). The OJT settings overwrite the settings defined in the Océ 
Settings Editor. Except for pen settings and job management which have 
priority over the Océ Job Ticket settings.

Application
Software

Océ TDS300

Printfile 
Print

Job
Settings

Print
File
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To compose such a header, you can:
■ Compose the header within your application. Please refer to the Océ Job 

Ticket (OJT) manual.
■ Use a Windows® or AutoCAD® HDI driver to generate both a printable file 

(e.g. HP-RTL, HP-GL/2) and the appropriate header with RCF-commands. 
Please refer to the Windows® / AutoCAD® Driver documentation.

■ Use the Océ job submission software like Océ Print ExecTM to compose jobs 
of printable files in a flexible and user friendly way. Please consult the 
on-line help on the Océ Print ExecTM application for detailed information.
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How to turn on and turn off the Océ 
TDS300 

To turn on the system:
■ turn on the printer. 
■ turn on the scanner (see page 43).
■ turn on the controller (see page 17)
When you turn on the system, it is ready for operation.

If the system is not in use for more than 90 seconds, the operator panel returns 
automatically to the stand-by mode. The operator panel of the scanner is 
activated in the following conditions:
■ you feed an original
■ a key on the operator panel is pressed

▼ Turn on the printer

1 Set the ON/OFF switch at the rear of the printer to position ‘1’ (see figure 3).

[3] On/off switch of the printer

Note: When ‘Ready’ is displayed on the operator panel, the printer is ready for 
use.

1 Set the ON/OFF switch at the rear of the printer to position ‘0’ (see figure 3).
2 If you switch off the printer during a print job, it is possible that you lose 

information or that a paper jam occurs.
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▼ Turn on the Océ Power Logic® Controller

1 Press the button on the front of the controller, to turn on the controller. 

▼ Turn off the Océ Power Logic® Controller

1 Press the button on the front of the controller, to turn off the controller.
Introduction 17
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Océ TDS300

User Manual
Chapter 2
Use the Océ TDS300 to print

This chapter explains how to print with the Océ TDS300.
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Printer operator panel

The operator panel on the right hand side is easy to use (see figure 4). The 
panel has keys and a display.

[4] Printer operator panel

Display

The display shows the feedback about print job status and error messages see 
page 33 and page 34 in normal mode. In off-line mode it shows the ‘off-line’ 
menu (see figure  on page 36).

Menu level indicator

The menu level indicator indicates the current position in the menu. Press the 
Previous key to scroll through the menu.

nästa/välj

föregående

on-line stopp

Stop key

On-line
key

Browse 
keys

Next/select
key

Previous
key

Alphanumeric display
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[5] Menu level indicator in the top level of the menu

Keys

With the keys on the operator panel you can make the settings for the Océ 
TDS300 Printer.

The following keys are available

 

Available keys
Key types Function
On-line key Press the On-line key to put the printer on-line or off-line. To 

activate the program mode and to enter the top level menu. You 
can use the Next/select key, the Previous key and the Browse 
key to go through the menu. If the green light above the On-line 
key is on, the printer is on-line; if this light is off, the printer is 
off-line.

Next/select key To select an option or a setting in the menu. Or in case a sub-
menu is present, enter a menu on a lower level.

Previous key Press this key to go one level higher in the menu.
Browse keys These two keys are used to select another mode at the same lev-

el of the menu, or to display the next or previous option from 
the option list.

Stop key The red Stop key is used to stop the current print job. 
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How to turn on and turn off the Océ 
TDS300 printer

(see chapter , ‘How to turn on and turn off the Océ TDS300’ on page 16)

Cancel a print

Cancel a print before you start the print or during the print.

▼ Cancel a print

1 Press the Stop key.
2 The printer stops. 

When the printer runs, the paper is cut.
The paper is always ejected.
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Menu structure

On the Océ TDS300 printer operator panel, you can do a number of actions. 
These actions include: 
■ Media settings (material and size).
■ Print info (configuration report, menu card and demo print).
■ Configuration (connectivity issues).
■ System (clear set memory and diagnostic mode).

Media type and size on the printer

One of the features of the Océ TDS300 printer are the 2 rolls with the 
automatic media change function. This function allows the printer to take 
another roll of the same format and copy material when the roll becomes empty 
when you print. You must configure this setting in the Océ Settings Editor (see 
‘Printer supplies and maintenance’ on page 87). 

If you activate this function the machine automatically switches to the other 
roll, if the used one becomes empty. The switch only occurs if the kind of 
media and the width of the material is the same for both rolls.

Note: The Océ TDS300 Printer can not identify the copy material type and 
format. Fill the media and indicate the type and the size as described in 
chapter , ‘Media’ on page 88.

See ‘List of available material types and sizes’ on page 109 for a summary of 
all materials for the use with the Océ TDS300 Printer.

If you insert a new roll with another material or with a different width, you 
have to program the new roll specifications. Refer to ‘List of available material 
types and sizes’ on page 109.

Note: The machines switches automatically to the other roll if the used roll 
becomes empty, if you activate this function in the Océ Settings Editor. 
Use the Océ TDS300 to print 23



▼ Set the media width settings

1 Press the On-line key to put the printer off-line.
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’or ‘Roll 2’ with the  or  key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Width’ item with the  or  key.
7 Press Next/select to enter the ‘Width’ menu.
8 Select the desired width with the  or  key.
9 Press Next/select to confirm the selected width.

10 Press On-line to put the printer on-line again.

▼ Set the media type settings

1 Press the On-line key to put the printer off-line. 
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Roll 1’, ‘Roll 2’, ‘Manual feed’ with the  or  key.
5 Press Next/select to enter the ‘Roll’ or ‘Manual feed’ menu.
6 Select the ‘Material’ item with the  or  key.
7 Press Next/select to enter the ‘Material’ menu.
8 Select the desired media material with the  or  key.
9 Press Next/select to confirm the selected media material.

10 Press On-line to put the printer on-line again.

Manual feed

There are two possibilities to select manual feed:
■ via remote control commands added to the print file (for example with the 

printer drivers).
■ choose ‘manual feed’ on the scanner operator panel.
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[6] Manual feed

If you want to use manual feed, you must:
1 program the media settings (material and feed time out) on the printer
2 send the file
3 feed the sheet of material
4 hold the material until the printer pulls in the first part of the material.

If you select manual feed, the printer will inform you to feed the sheet into the 
printer. There is a time out between 1 and 10 minutes. Default is 1 minute. 

▼ Set the time-out for manual feed

Default is 1 minute.

1 Press On-line to put the printer off-line.
2 Select the ‘Media settings’ item with the  or  key.
3 Press Next/select to enter the ‘Media settings’ menu.
4 Select ‘Manual feed’ with the  or  key.
5 Press Next/select to enter the ‘Manual feed’ menu.
6 Select the ‘Time out’ with the  or  key. 
7 Press Next/select to enter the ‘Time out’ menu.
8 Select the desired time out with the  or  key.
9 Press Next/select to confirm the selected time-out.

10 Press On-line to put the printer on-line again.

Cut media

If the material does not have a straight leading strip, you can cut the material 
at right angles from the roll.
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▼ Cut the material from roll 1 or roll 2

1 Open the drawer.
2 Feed the paper manually until it is 5 cm above the top drawer.
3 Press the On-line key to put the printer off-line.
4 Close the paper drawer.
5 Select the ‘Media settings’ item with the  or  key.
6 Press Next/select to enter the ‘Media settings’ menu.
7 Select ‘Cut media’ with the  or  key.
8 Press Next/select to cut the paper.
9 Open the paper drawer.

10 Remove the scrap of material.
11 Feed the material until you can see the material and put the material into 

position (see figure 25 on page 91) and (see figure 29 on page 93).
12 Close the drawer.
13 Press the On-line key to put the printer on-line again.
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Print info

You have the possibility to print:
■ the configuration report
■ the menu card
■ a demo print

Print the configuration report

The configuration report shows the configuration and the settings of the 
system.

▼ How to print the configuration report

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Configuration’ item with the  or  key.
5 Press Next/select to print the configuration report.
6 Press On-line to put the printer on-line again to print the report. 

Print the menu card

You can print the menu of the printer, to guide you through the menu.

▼ How to print the menu card

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Menu card’ item with the  or  key.
5 Press Next/select to print the menu chart.
6 Press On-line to put the printer on-line again to print the menu card.

Print the demo print

After the installation of the Océ TDS300, you can print the demo print, to 
check the printer and the controller.
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▼ Make a demo print

1 Press the On-line key to put the printer off-line.
2 Select the ‘Print info’ item with the  or  key.
3 Press Next/select to enter the ‘Print info’ menu.
4 Select the ‘Demo print’ item with the  or  key.
5 Press Next/select to print the demo print.
6 Press On-line to put the printer on-line again to print the demo print.
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Configuration

Select a language

On the operator panel of the Océ TDS300 Printer you can indicate which 
language you use to display the printer information, like status and error 
messages.

▼ Select a language

1 Press the On-line key to put the printer off-line. 
2 Select the ‘Configuration’ item with the  or  key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Language’ with the  or  key.
5 Press Next/select to enter the ‘Language’ menu.
6 Select the desired language with the  or  key.
7 Press Next/select to confirm the selected language.
8 Press On-line to put the printer on-line again.
9 Turn the printer ‘off’ and ‘on’ again.

Network settings

The Océ TDS300 has 2 network adapters. To set the network settings you must 
enter the network data in 4 fields.
■ Use DHCP server. The Dynamic Host Configuration Protocol (DHCP) is a 

protocol to automate the assignment of Internet Protocol (IP) addresses in a 
network. Without DHCP, the IP address must be entered manually.

■ IP address. An IP address has two parts: one part identifies the network (with 
the network number) and the other part identifies the specific machine or host 
within the network (with the host number).

■ Subnetmask. A subnet (short for ‘subnet work’) is an identifiably separate 
part of an organization's network. To manage routing that could and should 
be handled within an organization. 

■ Set default gateway A gateway is a network point that acts as an entrance to 
another network. 

Press the following key sequence to enter the System menu password on the 
printer to set the network settings.
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▼ Enter the System menu

1 Press arrow left ( ).
2 Press the Stop key.
3 Press arrow right ( ).
4 Press the Stop key.
5 Press arrow left ( ).
6 You can now enter the System menu.

▼ Set use DHCP server

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Use DHCP server.’ with the  or  key.

10 Select ‘Yes’ or ‘No’ with the  or  key.
11 Press Next/select to confirm.
12 Press On-line to put the printer on-line again.

▼ Set the IP address

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘IP address’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘IP address’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘IP address’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘IP address’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘IP address’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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▼ Set the Subnetmask

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Subnetmask’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘Subnetmask’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Subnetmask’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Subnetmask’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Subnetmask’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.

▼ To set the Default gateway

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter password.
5 Select ‘Network sett.’ with the  or  key.
6 Press Next/select to enter the ‘Network sett.’ menu.
7 Select ‘adapter 1’ or ‘adapter 2’with the  or  key
8 Press Next/select to enter the ‘adapter 1’ or ‘adapter 2’ menu
9 Select ‘Default gateway’ with the  or  key

The first three digits flash.
10 Enter the first three numbers of the ‘Default gateway’ with the  or  key. 
11 Press Next/select to confirm, the next digits flash.
12 Enter the next three numbers of the ‘Default gateway’ with the  or  key.
13 Press Next/select to confirm, the next digits flash.
14 Enter the next numbers of the ‘Default gateway’ with the  or  key.
15 Press Next/select to confirm, the next digits flash.
16 Enter the next numbers of the ‘Default gateway’ with the  or  key.
17 Press Next/select to confirm.
18 Press On-line to put the printer on-line again.
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Paper series

You must enter the paper series that you use in the printer. Choose between:
■ DIN
■ DIN CARTO
■ Only 8.5 inch
■ Mix 8.5/9 inch

▼ To set a paper series

1 Press the On-line key to put the printer off-line.
2 Select the ‘Configuration’ item with the  or  key.
3 Press Next/select to enter the ‘Configuration’ menu.
4 Select ‘Paper series’ with the  or  key.
5 Press Next/select to enter the ‘Paper series’ menu.
6 Select the required paper series with the  or  key.
7 Press Next/select to confirm.
8 Press On-line to put the printer on-line again.

Clear set memory

The set memory indicates the available memory. If an error occurs, for example 
the set memory reaches its limits, you must clear the set memory.

▼ Clear set memory

1 Press the On-line key to put the printer off-line.
2 Select the ‘System’ item with the  or  key.
3 Press Next/select to enter the ‘System’ menu.
4 Enter the password to get access.
5 Select the ‘Clear setmem’ item with the  or  key.
6 Press Next/select to enter the ‘Clear setmem’ menu.
7 Select ‘Yes’ or ‘No’ with the  or  key.
8 Press Next/select to confirm the setting.
9 Press On-line to put the printer on-line again.

10 Turn ‘off’ and ‘on’ the controller.

Diagnostic mode

The Diagnostic mode is only meant for the Océ service technician.
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Status messages

Status Messages
Status messages Explanation
Off-line The printer is off-line.

Change options.
Reset printer Turn the printer off and turn the printer on.
Connecting..... There is no communication between the controller and the print-

er.
Wait until there is communication.

Printer asleep The printer is in low power mode. 
The energy is saved.

Please wait The printer down loads the language.
Wait until the printer is prepared to operate.

Printer ready The printer is prepared to print.
Preparing job The printer prepares a print or copy job.
Printing The printer prints.
Load roll 1
A2
Paper

The printer detects that the required media is not available on roll 
1.
Fill roll 1 with the indicated media.

Load roll 2
A2
Paper

The printer detects that the required media is not available on roll 
2.
Fill roll 2 with the indicated media.

Manual feed
A2
Paper

The printer detects that the required media is not available in the 
manual feed.
Put the required media in the manual feed.

Open left cover
Refill toner
Press <on-line>

The toner container is empty.
Refill the toner container.

Conditioning The machine improves the print quality by optimizing the 
toner concentration.
Wait until the toner concentration is at the correct level.

Printer ready
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1.

Printer ready
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2.

Printer running
Roll 1 empty

The paper roll 1 is empty.
Reload roll 1 after the printers stops printing.

Printer running
Roll 2 empty

The paper roll 2 is empty.
Reload roll 2 after the printers stops printing.

Job canceled The current print or copy job is canceled
Close roll unit The roll unit is open.

Close the roll unit.
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Error messages

Sensor not free
Remove paper
Press <on-line>

The paper of one of the rolls is transferred after the marker (see 
‘Feed the material’ on page 91 and ‘Feed the material’ on 
page 93) when power is applied to the printer.
Take the paper back.
Press <on-line>

Paper retracted
Press <on-line>

Put the paper into the manual feed.
Press <on-line>

Copy too short
Remove paper
Press <on-line>

The length of the print material is less than 420 mm. This can oc-
cur with the manual feed.
Use an original longer than 420 mm.

Input flap open
Close input flap

The input flap is open.
Close the input flap.

Input flap open
Remove paper
Press <on-line>

The input flap is open during the print process
Remove the paper and press <on-line>.

Roll 1 empty
Open roll unit

The paper on roll 1 is empty.
Open the roll unit and replace it.

Roll 2 empty
Open roll unit

The paper on roll 2 is empty.
Open the roll unit and replace it.

Error messages
Error messages Explanation
Copy too late
Remove paper
Press <on-line>

The copy is too late at the paper path output sensor
Remove the print material.

Speed failure
Remove paper
Press <on-line>

A paper jam occurred.
Remove the paper jam and press <on-line>

Knife 1 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Knife 2 error
Remove paper
Press <on-line>

An error occurred during the cut of the roll.
Check the paper in the roll unit and remove if necessary.
Press <on-line>.

Roll retract err
Press <on-line>

Print material error when the roll unit takes back the material.

Status Messages (continued)
Status messages Explanation
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Roll unit error
Open roll unit
Press <on-line>

A sensor of the roll unit is activated when power is applied to the 
printer.
Open the roll unit.
Guide the paper to the marker (see ‘Feed the material’ on page 91 
and ‘Feed the material’ on page 93)
Press <on-line>

Input too late
Open roll unit
Press <on-line>

The input sheet is too late.
Open the roll unit
If necessary, withdraw roll and rewind
Press <on-line>

Deposit error
Press <on-line>

An error in the compact output stacker occurred.
The compact output stacker stops.
The print process continues.
Press <on-line>.

Illegal language 
on controller
using UK English
Press <on-line>

The controller has an illegal language.
The controller uses the English language instead of the selected 
language.
Call service.
Press <on-line>

Close roll unit
Rewind paper
Press <on-line>

While you printed, the roll unit opened.
Rewind the paper.
Close the roll unit.
Press <on-line>

Error messages (continued)
Error messages Explanation
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Menu structure of the printer

When you browse through the tree, the left items are displayed on top. The 
upper items are displayed first.

A0 (841x1189mm)
A1 (594x841mm)
A2 (420x594mm)
A3 (297x420mm)
B1+ (700x1000mm)
B2+ (500x700mm)
B1 707x1000mm)

Width B2 (500x707mm)
E (34x44”)
D (22x34”)
C (17x22”)
B (11x17”)

Roll 1 E+ (36x48”)
D+ (24x36”)
C+ (18x24”)

Roll 2 B+ (12x18”)
30x42”

Media settings Paper 64g
Paper 75g

Transparent 75 g
Transparent 90 g

Material Transparent 110g
Vellum

Material Film 3.5
Film 4.5

Manual feed Translucent

Time out 67 seconds

Cut media Cutting...

Configuration Printing...

Print info Menu card Printing...

Demo print Printing...

UK English
Language Nederlands

more...
Configuration

DIN
Paper series DIN CARTO

ONLY 8.5”
MIX 8.5/9”

Clear setmem Yes
No

System Enter
password

Diagnostic
mode

Yes

No

Use DHCP
server

Yes

No

Network sett. adapter 1 IP address 123.456.789.123

Subnetmask 123.456.789.123

Default
gateway

123.456.789.123

Use DHCP
server

Yes

No

adapter 2 IP address 123.456.789.123

Subnetmask 123.456.789.123

Default
gateway

123.456.789.123

Installation Enter password start install.
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User Manual
Chapter 3
Use the Océ TDS300 to copy

This chapter contains a description how to copy with the 
Océ TDS300.
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Scanner operator panel

Make the settings with the scanner operator panel. The display gives you the 
feedback and the available menu options.

.

[7] Scanner operator panel

+-starta avbryt

kantexponering

inmatning utmatning extra

uppsättning fil

zooma

ark kopiering

superior

inferior

rulle 1

rulle 2

manuell

material

Input key Extra keyOutput 
key

Alphanumeric 
display

Browse keys

Confirm
key

Strip key

Copy quantity 
display

Cancel key

+ key

Zoom key

Exposure 
key

- key

Start key

Media key
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The keys
The Extra key  This key allows you to enter the Extra mode of the scanner and 
return to the normal mode. Set the properties for the original and for the 
scanner in the Extra mode.

The Browse keys (left , right )  Move in one level of the menu structure as 
the display shows. Browse the preset zoom values.

The Browse keys (up , down )  Move between the levels of the menu 
structure as the display shows. Adjust the zoom value with an accuracy of 1 
percent.

The Confirm key  Confirm the current setting in the menu structure. If you 
press the confirm key a second time in the current menu item, you restore the 
previous setting.

The Strip key  Press this key to add or to remove a ‘leading’ or a ‘trailing’ strip. 
The icon flashes. Use the browse keys (left , right , up , down ) to change 
the value. The icon remains on if you press another settings key and select a 
different value than the default value.

The Cancel key  Press this key one time to set the copy counter to the default 
value. Press this key twice to change all settings to their default values. The 
scan stops if you press this key.

The - and + keys  Change the number of copies.

The Start key   Press the green start key  to start the scan or to restart the 
copy process.

The Zoom key  Enters the zoom mode. The icon flashes. Use the browse keys 
(left , right ) to browse the preset zoom values. Use the browse keys (up , 
down ) to adjust the zoom value with an accuracy of 1 percent.

The Exposure key  enters the exposure mode. The icon flashes. Use the browse 
keys to change the exposure value.

The Media key  Select roll 1, roll 2 or manual feed. The equivalent icon is on.
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The display

The display shows the feedback about the scan job status (see table below) in 
normal mode. In off-line mode it shows the off-line menu (see page 56).

Status messages 
Status Messages Explanation
Scanner ready The scanner is prepared to scan.
Connecting..... There is no communication between the controller and the 

scanner.
Wait until the there is communication.

Scanner asleep The scanner is in low power mode.
Scanner running The scanner scans.
Please wait The scanner downloads the languages.
Remove original
Press <cancel>

There is an original on the table while you turn on the scan-
ner.
The message appears if you pressed the Cancel key while 
you scan.
Remove the original.
Press cancel.

Original too long
Press <cancel>

Use an original shorter than 15 meter.

Wrong orig. type
Press <cancel>

This message shows when you select ‘Background compen-
sation’ and ‘Blueprint’ as original.
Press cancel.

Reset scanner Turn the scanner on and off.
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Menu level indicator

The menu level indicator indicates the current position in the menu. Press the 
Previous key to scroll through the menu.

[8] Menu level indicator on the scanner operator panel

inmatning utmatning extra

uppsättning fil

ark kopiering
Use the Océ TDS300 to copy 41



Copy jobs

Your printer system has a 1 roll or 2 roll unit. Use the Media key, on the scanner 
operator panel, to select a roll, or to select the manual feed on the printer. 

Note: You must set the media type on the printer. 

You can make 1:1 copies and you can decrease or increase your original from 
25% to 400%. You can set the zoom value in fixed steps or in% steps. The 
default zoom is set in the Océ Settings Editor.

The Océ TDS300 cuts the paper to the length of the original, the synchro cut. 
If you select the standard cut mode, the copy is cut at a standard length, (see 
‘Set synchro or standard cut’ on page 52).

The automatic exposure gives background-free copies from most 
line-drawings. Select the correct original type if you have an extremely dark or 
light original, or an original with pasted parts or photographs (see ‘The 
exposure settings’ on page 46). 

With the Océ TDS300 you can do a number of basic tasks. These tasks include:
■ Turn on, turn off the scanner
■ Make copies
■ Select the required media
■ Select the manual feed
■ Specify the zoom factor
■ Select the exposure setting
■ Select to add or remove a strip
■ Select extra settings
■ Deliver originals after scanning
■ Define settings for the next original
■ Select autofeed of the original
■ Stop a copy job
42 Océ TDS300 User Manual



You can also do a number of special copy jobs. These special copy jobs 
include:
■ Copy non standard size originals
■ Define the copy size
■ Define image quality: Optimization for lines & text, photo or blueprint mode
■ Background compensation for line/text/photo or blueprint mode
■ Edit function: mirror

Turn on and turn off the Océ TDS300 scanner

(see chapter , ‘How to turn on and turn off the Océ TDS300’ on page 16)

Start the copy process

If you press the Start key, and you do not change any settings, the settings of 
the previous copy job are used or the default settings of the machine are used:
■ number of copies 1
■ use roll 1
■ zoom 100%
■ synchro cut
■ no leading or trailing strip
■ auto exposure on; exposure setting 0.

Default settings are used in the following situations:
■ after turn on
■ after you press ‘cancel’ twice
■ after the panel time-out expires the system settings return to the default 

values.

If the Start key is pressed the original will be scanned. The original returns to 
the operator if you have enabled the rewind function (see page 48). You can 
make settings for the next job.

When the original returns, remove the original. A new original can be fed and 
you can program new settings. 
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Make copies

The copying process starts when you press the Start key. Before you press the 
Start key, you can change the settings.

▼ Feed the original

1 Insert the original face down and right aligned, along the original guide line on 
the scanner feed table so that you can see the line (see figure 9).

[9] Insert the original

The original will be transported about 1 centimeter to a defined position.
2 Specify the number of copies with the ‘+’ or ‘-’ keys.
3 Press the ‘media’ key to select a roll or to select ‘manual feed’.
4 Press the ‘zoom’ key to specify a reduction or an enlargement factor, if needed.
5 Press the ‘exposure’ key to correct for a lighter or darker original, if needed.
6 Press the ‘strip’ key to add or remove a strip, if needed.
7 Press the green Start key to start the copy job. The original is fed into the 

scanner. The printer starts.
8 Collect your output. 

If you make a copy within the time-out of 90 seconds, the machine will use the 
settings of the previous copy job.
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Number of copies

To have multiple copies from one original, enter the number of copies on the 
scanner operator panel. The original is scanned just once and the required 
number of copies are processed.

Refer to ‘Product specifications Océ TDS300’ on page 105 for the limitation 
of multiple copy jobs.

▼ Select the number of copies

1 Enter the number of copies (1 up to 99) with the ‘+’ or ‘-’ key on the scanner 
operator panel.
The display shows the number of copies.

Select the use of roll 1 or roll 2 or manual feed

You can select between two rolls or manual feed with the ‘media’ key. When 
a roll is selected, the copy material is taken from the selected roll. 

Note: Only use paper as specified in ‘List of available material types and sizes’ 
on page 109.

▼ Select roll 1, roll 2

1 Press the ‘media’ key until the indicator that matches your selection lights.
2 Enter the media width if you have selected ‘Manual feed’ (see ‘Media type and 

size on the printer’ on page 23).
3 Set the correct media type settings (see ‘Set the media type settings’ on 

page 24).
4 Press the confirm key.
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Specify the zoom factor

With the Océ TDS300 you can reduce or enlarge your original from 25% to 
400%. Press the ‘zoom’ key to enter the zoom mode. You can select the zoom 
factor by means of the ‘browse’ keys when the indication flashes. 
Choose between the fixed step zoom mode by means of the right and left 
browse keys. In fixed steps mode 8 pre-set zoom settings are available. Choose 
the% zoom mode by means of the up and down browse keys. 

Note: You can configure the fixed zoom steps in the Océ Settings Editor. Also 
refer to ‘Summary of standard zoom formats’ on page 112.

▼ Select the zoom factor with pre-set zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the  or  key.

The display shows the selected ratio. If you make the adjustments with this key, 
one of the indications above the key flashes. If the adjustment is different from 
the default setting, the indication lights. 

▼ Select the zoom factor with 1% zoom steps

1 Press the ‘zoom’ key. The indicator flashes.
2 Specify the zoom ratio with the  or  key.

The display shows the selected ratio. If you make adjustments with this key, 
one of the indications above the key flashes. If the adjustment is different from 
the default setting, the indication lights. 

The exposure settings

You can modify the exposure quality to improve the image quality. To modify 
the exposure you can choose between:
■ use of the lighter and darker keys
■ enable or disable automatic background compensation
■ adjust the Océ Image Logic® based on the original type you want to copy

The default exposure settings makes background-free copies of most line 
drawings. The automatic background compensation is activated. The 
background is measured when you scan an original. The result of some 
originals can not match your requirements.
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When you copy very light or dark originals, or originals with unequal 
background density, the result can not meet your requirements (e.g. too much 
background).

Default the automatic background compensation is active and the exposure 
level is 0.

The automatic background compensation will provide a good quality copy 
from a large variety of originals. The automatic background compensation  
setting, which is switched on (by default), ensures the production of 
background-free copies of most line drawings. 

▼ Adjust the exposure setting

1 Press the ‘Exposure’ key.
2 Select the needed exposure value with the  or  key.

▼ Set the automatic background compensation

1 Press the Extra key.
2 Select ‘Original’ with the  or  key. 
3 Press the  key to enter the ‘Original’ menu.
4 Select ‘Background comp.’ with the  or  key.
5 Press the  key to enter the ‘Background comp. menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the confirm key.

The Océ TDS300 allows you to adjust the exposure setting according to the 
type of image on the original. There are three original types available:
■ Lines/text
■ Photo
■ Blueprint

By default ‘Lines/text’ is selected with the background compensation enabled. 
This is the best setting for originals with characters and line art.
■ Select ‘Photo’ when the original consists of a combination of characters, line 

art and picture images.
Note: If you select ‘Photo’, the ‘Background compensation’ will be 
switched off automatically.
■ Select ‘Blue print’ when you want to copy an original with an image in 

negative (image in white on dark background). The copy will be positive 
(image in black on white background).
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▼ Improve the copy quality according to the type of image

1 Press the Extra key.
2 Select ‘Original type’ with the  or  key.
3 Press the  key to enter the ‘Original type’ menu.
4 Select ‘Lines/text’, ‘Blueprint’ or ‘Photo’ with the  or  key.
5 Press the  key to enter the ‘Lines/text’, ‘Blueprint’ or ‘Photo’ menu.
6 Select the needed original type.
7 Press the confirm key.

Deliver originals after scanning

You can choose for delivery of the original at the front (rewind) or the rear side 
of the scanner. Use the output at the rear side of the scanner if your originals 
are:
■ thick
■ very thin
■ damaged
■ in a carrier sheet.

The rewind setting will return to default when,
■ the Cancel key is pressed,
■ the panel time out has exceeded.

▼ Enable the rewind function

1 Press the Extra key.
2 Select ‘Scanner’ with the  or  key.
3 Press the  key, to enter the ‘Scanner’ menu.
4 Select ‘Rewind original’ with the  or  key.
5 Press the  key, to enter the ‘Rewind original’ menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the Confirm key.

Enable automatic feed of the original
To increase the productivity enable Automatic feed, no need to press the Start 
key, except for the first original. If you disable automatic feed you must press 
the Start key.
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▼ To enable automatic feed

1 Press the Extra key.
2 Select ‘Scanner’ with the  or  key.
3 Press the  key, to enter the ‘Scanner’ menu.
4 Select ‘Autofeed orig.’ with the  or  key.
5 Press the  key, to enter the ‘Autofeed orig.’ menu.
6 Select ‘on’ or ‘off’ with the  or  key.
7 Press the Confirm key.

Define settings for the next original

For each original you need to copy you can specify new settings. 

▼ Define settings for the next copy job

1 Select all the needed settings for the next original.
2 Insert the next original.

Copy on pre-cut sheets

If you copy a job on a media type and/or size that is not available on one of the 
paper rolls, you can manually feed sheets instead of reloading paper rolls. You 
can insert pre-cut copy material in this slot, one sheet at a time. To set the time 
out for manual feed refer to ‘Set the time-out for manual feed’ on page 51.

▼ Copy on pre-cut sheets

1 Enter the type of the copy material on the printer operator panel.
2 Press the ‘media’ key on the scanner panel to select ‘manual feed’. The 

indicator lights.
Note: The minimum length of the print material must be 420 mm.
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[10] Manual feed

3 Enter the number of copies.
4 Select the copy size.
5 Feed the original.
6 Press the Start key .
7 Take your sheet of copy material to the side of the printer that contains the 

sheet feed (see figure 10). 
8 Align the copy material with your hands to the format indication and the label 

on the manual feed table.
9 Move the copy material forward in the cut of the roller. A paper bulge must 

appear over the full width of the page.
10 Hold the paper with your hands until the printer pulls in the first part of the 

sheet.
The bulge decreases or disappears. After a few seconds, the printer pulls the 
complete sheet.

11 Repeat the steps 7 to 10 to complete the job.
12 Collect your output.

Note: The printer prints the image on the side of the sheet which is facing up.

Attention: When you feed a sheet of material in the manual feed while a 
normal print job runs, a media jam can occur.
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▼ Set the time-out for manual feed

Default is 60 seconds.

1 Press On-line on the printer operator panel, to enter the main menu.
2 Select the ‘media settings’ item with the  or  key.
3 Press ‘next/select’ to enter the ‘media settings’ menu.
4 Select ‘manual feed’ with the  or  key.
5 Press ‘next/select’ to enter the ‘manual feed’ menu.
6 Select the ‘time out’ with the  or  key. 
7 Press ‘next/select’ to enter the ‘time out’ menu.
8 Select the desired time out with the  or  key.
9 Press ‘next/select’ to confirm the selected time-out.

10 Press On-line to leave the main menu.
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Stop a copy job

Press the Cancel key to interrupt the original transport. 

▼ Stop a job

1 Press the Cancel key.
The original transport is stopped.

2 The message ‘Remove original’, ‘Press cancel’ appears on the scanner display.
3 Open the scanner cover and remove the original.
4 Close the cover.
5 Press the Cancel key. The message disappears on the scanner display.

Set synchro or standard cut

In synchro cut mode, the copy is cut at the length of the original. The length 
depends on the zoom factor and the leading or trailing strip setting. The default 
is Synchro cut mode.

In standard cut mode, the copy is cut at a standard format length (portrait). You 
select the length of the standard format with the ‘browse’ keys. 
Example: select 36 inches, means select a format of 36 inches width and a 
corresponding 48 inches length. Independent of the roll width, the material is 
cut at a length of 48 inches.

When you select standard cut, the system always cuts at the selected length. If 
the original length is shorter or longer than the selected length, the cut is made 
at the selected length. 

▼ Select synchro cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press  key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the  or  key.
5 Press  key, to enter the ‘cut length’ menu.
6 Select ‘Synchro cut’ with the  or  key.
7 Press the Confirm key.
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▼ Select standard cut

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press  key, to enter the ‘Paper copy’ menu.
4 Select ‘cut length’ with the  or  key.
5 Press  key, to enter the ‘cut length’ menu.
6 Select a standard paper format with the  or  key.
7 Press the Confirm key.

Adjust the leading or the trailing strip

To increase the copy length to accommodate for a filing strip select a positive 
leading or trailing strip. 

If you do not want the filing strip to show on the copy, select a negative leading 
or trailing strip. The adjustment steps are indicated on the operator panel, 
expressed in millimeters or 0.1 inches (for systems in the US). 

▼ Adjust the leading or the trailing strip

1 Press the ‘strip’ key to toggle between ‘leading’ and ‘trailing’ strip. 
2 Select a positive or negative value in steps of 10 mm with the  or  key.
3 Select a positive or negative value in steps of 1 mm with the  or  key.

The length of the selected strip is shown in the display. If the adjustment differs 
from the default setting, the indication lights. 

Attention: If you make the strip larger than the strip on the original, you can 
lose information.
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Leading and trailing strip  It is possible to adjust the length of both the leading 
and trailing strip to eliminate or add a filing strip. Leading and trailing strips 
can be extended up to 400 mm or shortened up to 400 mm (see figure 11).

[11] Example of adjusting the leading and trailing strip of an original 

Trailing strip
-400 mm Trailing strip

+400 mm

Leading strip
-400 mm

Leading strip
+400 mm
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Mirror-image copies

You can make a mirror-image copy of an original, as shown in the next figure:

[12] Example of a mirror-image copy

▼ To make a mirror-image copy

1 Press the Extra key.
2 Select ‘Paper copy’ with the  or  key.
3 Press the  key to enter the ‘Paper copy’ menu.
4 Select ‘Mirror’ with the  or  key.
5 Press the  key to enter the ‘Mirror’ menu.
6 Select ‘on’ or ‘off with the  or  key.
7 Press the confirm key.
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Menu structure of the scanner
f

Rader/text
Originaltyp Blåkopia

Original Foto

Bakgr.komp. på
av

Synkron skärning
A0 (841x1189 mm)
A1 (594x841 mm)
A2 (420x594 mm)
A3 (297x420 mm)
E (34x44 tum)
D (22x34 tum)
C (17x22 tum)

Skärningslängd B (11x17 tum)
E+ (36x48 tum)
D+ (24x36 tum)
C+ (18x24 tum)
B+ (12x18 tum)

30x42 tum
Papperskopia B1+ (707x1000

mm)
B2+ (500x707 mm)
B2 (500x700 mm)

Poster-läge på
av

Spegelvänd på
av

Återspola orig. på
av

Auto. inmatning på
av

Skanner
UK English

Språk Nederlands
mer...

Skrv menystrktur Skriver ut...
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User Manual
Chapter 4
Install and start Océ Remote 
Logic® on a workstation

This chapter describes how to install and start Océ Remote 
Logic® on a workstation.
57



Introduction

Océ Remote Logic® to access the Océ Settings Editor (‘Océ Power Logic®: 
The Settings Editor’ on page 67) from a remote workstation.
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Installation procedure for MS Windows® 
systems

Before you install Océ Remote Logic®, you must take note of the following 
minimum system requirements for the remote system. The system must be a 
Pentium® 233 with 32 Mb RAM running Windows 95, 98, NT® (service pack 
3), Windows® 2000, or Windows® XP. Contact your local Océ organization for 
more possible systems.

You will find the Océ Remote Logic® application on the Océ TDS300 
CD-ROM and on the Océ Power Logic® Controller CD-ROM provided with 
the system. The installation procedure for Remote Logic® is quite simple and 
self-explanatory. When you select the ‘Install remote applications’ option on 
the CD-ROM, a Wizard starts to guide you through the installation process. 
When the installation process is complete you do not have to restart your 
system.

Note: Océ Remote Logic® only works when TCP/IP is enabled on your system. 
Refer to your system administrator for assistance with the installation 
procedure for TCP/IP.

▼ Install Océ Remote Logic® 

1 Insert the Océ Remote Logic® CD-ROM or the Océ Power Logic® Controller 
CD-ROM into the CD-ROM drive of your PC.

2 Select the ‘Install remote applications’ option. 
The installation Wizard starts, and asks to select a setup language.

[13] Choosing a setup language
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3 Indicate the required language and click ‘OK’. 
4 Follow the instructions on screen to complete the installation of ‘Océ Remote 

Logic’.

When the installation is complete, you can start the applications by selecting 
them from the specified folder in the ‘Start’ menu. 

To work with Océ Settings Editor you first have to connect to an available Océ 
TDS300 machine. How to connect is described in ‘How to connect to a 
controller’ on page 70.
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Installation procedure for Unix systems

Océ Remote Logic® is set up to be platform independent. It runs on a variety 
of operating systems providing that a Java™ runtime environment is available 
for that platform. The Java™ runtime environment must be installed by a user 
with system administrator privileges, depending on Java™ Virtual Machine 
(VM). It is also assumed that Océ Remote Logic® is installed by an 
experienced user.

▼ Install Océ Remote Logic®’

1 Check if a Java™ runtime environment (JRE) is installed on the system. The 
preferred version is JRE 1.1.8. Below you can find some links to JRE's for 
various UNIX platforms.

2 Unpack the contents of the file ‘RemoteLogic_vX.tar’, from the directory 
Products/remotelogic/UNIX, to a subdirectory on the system. 

3 Use ‘tar xvf RemoteLogic_vX.tar’ to unpack.
4 Set the environment variable ‘RL_VM_HOME’ to point to the installation of 

the JVM.
5 Run the file ‘remotelogic’ with Océ Settings Editor as parameter. (remotelogic 

SE). 

Note: If you do not supply any options, a short help text is displayed.

UNIX versions and the required JRE
UNIX version OS version JRE Default installation directory
IBM AIX 4.1.5 1.1.6 /usr/jdk_base
IBM AIX 4.2.1 1.1.8 /usr/jdk_base
IBM AIX 4.3.3 + fix 1.2.2 /usr/jdk_dev2
IBM AIX 4.3.3.10 + fix 1.3.0 /usr/jdk_java130
SUN Solaris 2.6 1.1.6
HP-UX 10.20 / 11 / 1.1.8 1.1.3
LINUX 1.0 1.1.3
LINUX 1.2 1.1.8
Note: OS = Operating System, JRE = Java™ Runtime Environment
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IBM AIX

For the various versions of IBM AIX, Java™ runtime engines can be 
downloaded from:
http://www.ibm.com/java

The preferred version of the Java™ runtime engine for use with Océ Remote 
Logic® is the 1.1.8 version.

HP-UX

For HP-UX 10.20 and 11.00 the runtime engine can be downloaded from: 
http://www.unix.hp.com/java
The preferred version of the Java™ runtime environment for HP-UX 10.20 and 
HP-UX 11.00 is version C.01.18.xx.

Linux

IBM has a runtime engine available for Linux which can be downloaded from: 
http://www.ibm.com/java
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Installation procedure for Other systems

In general, Océ Remote Logic® can run on any system with a Java™ VM.

▼ Steps to install Océ Remote Logic® in general

1 Install Java™ Virtual machine (preferred 1.1.8 (or higher)).
2 Extract ‘RemoteLogic_vX.tar’ or ‘RemoteLogic_vX.zip’, from the Océ 

Remote logic® CD-ROM.
3 Set the environment variable RL_VM_HOME to point to the Java™ VM 

installation directory.
4 If needed, edit the remote logic script or batch file.
5 Use remotelogic script or batch file to start the applications.
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Start Océ Remote Logic®
 on your system

▼ Start Océ Remote Logic® 

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select ' Application Launcher'.
3 Select the Océ Settings Editor from the ‘Application Launcher’. 

Command line parameters

In order to start Océ Remote Logic® faster, there are 6 command line 
parameters available.

configfile=<config_file>  Sets the configuration file to use.

server=server  Sets the specified server as the server to connect to.

language1=lang   Specifies the first language in combination with the 
parameter ‘country1=country’.

country1=country  Specifies the first language in combination with the 
parameter ‘language1=language’.

language2=lang  Specifies the second language in combination with the 
parameter ‘country2=country’.

country2=country  Specifies the second language in combination with the 
parameter ‘language2=language’.

Note: You must always use a matching combination of ‘lang’ and ‘country’ 
(see table  on page 65).
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The parameters can be applied to the following application:
■ AL.exe (Application Launcher)
■ SE.exe (Océ Settings Editor)
Note: The.exe file is located in ‘C:\Program Files\Remote Logic\Bin’.

The easiest way to do this is by creating a short-cut of an application and then 
add the command line properties.

Example command line parameter  Below is an example of how to start the 
Océ Remote Logic® applications with the configuration file ‘Myconfig.cfg’, 
connected to the ‘MyTDS300’ server. The first language is set to Japanese and 
the second to French:
‘C:\Program Files\Remote Logic\Bin\AL.exe -configFile=Myconfig.cfg 
server=MyTDS300 language1=ja country1=JP language2=fr country2=FR’.

Language
Language Language

parameters
Country

Danish da DK
Czech cs CZ
Spanish es ES
Finnish fi FI
Hungarian hu HU
Italian it IT
US English en US
UK English en GB
Dutch nl NL
German de DE
French fr FR
Portuguese pt PT
Norwegian no NO
Swedish sv SV
Polish pl PL
Chinese tradition-
al

cn TW

Chinese simpli-
fied

cn CN

Japanese ja JP
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Océ TDS300

User Manual
Chapter 5
Océ Power Logic®: The Settings 
Editor

This chapter gives information about the Océ Settings 
Editor. For details about specific settings, refer to the 
on-line help on the Océ Settings Editor.
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Introduction

Use the Océ Settings Editor to set the default settings of the Océ TDS300 
according to your companies requirements. 
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How to start the Océ Settings Editor

Start up the Océ Settings editor on a remote client after you installed the 
software (see ‘Install and start Océ Remote Logic® on a workstation’ on 
page 57).

▼ Start Océ Settings Editor on a remote workstation

1 Select 'Océ Remote Logic' via the 'Start' menu.
2 Select the 'Launcher' application.
3 Select Océ Settings Editor. 
4 Océ Settings Editor starts.
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How to connect to a controller

In order to use the functionality you first have to add an Océ Power Logic® 
controller to the list of available controllers and then connect to an available 
controller.

▼ Add an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear with a drop-down list box containing the already 
added Océ Remote Logic® systems. 

2 Click ‘Edit...’. The ‘Edit systems’ dialog box appears.
3 Enter the IP address or the name of the Océ Remote Logic® system you want 

to connect to, in the ‘Systems’ text box.
4 Click ‘Add’. The system is added to the list. You can add as many systems.

Note: You can also remove an Océ Remote Logic® system. Select one in the 
list and click ‘Remove’.

5 Click OK twice to return to the application.

Note: Before you can add an Océ Remote Logic® system, the system has to be 
installed and configured by a system consultant or a technician.

▼ Connect to an Océ Power Logic® controller

1 Open the ‘File’ menu and select ‘Connect to’. 
A dialog box will appear containing a drop-down list box with the available 
systems. 
Select one of the available systems and click on ‘OK’. When you connect to 
another system, all settings have to be retrieved. This may take some time.
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An overview of the Océ Settings Editor

The Océ Settings Editor allows users and operators to view settings of the 
system. If authorized, the settings of the system can be modified on the Océ 
Settings Editor.

With the Océ Settings Editor two groups of settings can be configured:
■ Key Operator settings (KO settings)

The Key Operator group allows authorized users to configure default settings 
for copy and print jobs. With the Key Operator settings also the printer, 
system and scanner defaults can be set or modified. 

■ System Administrator settings (SA settings) 
The System Administrator group allows authorized users to configure 
default printer language (PDL) settings and printer pen settings. It also 
allows the System Administrator to configure system and connectivity 
settings.

These groups of settings can be selected from the ‘View’ menu of the Océ 
Settings Editor.

Setting dependencies  The Océ Settings Editor is used to display and edit a 
specified group of settings. Some settings are related to other settings, 
however. If you want to change settings which have dependencies with other 
settings you will be prompted with a message. When a setting is changed, the 
system automatically updates the related settings. 

Also, when you change certain settings, such as measurement unit or paper 
series, all related settings are instantaneously converted to the new setting 
(with a bullet for the settings that are changed).
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[14] Océ Settings Editor

General structure

The Océ Settings Editor is structured as follows: 
■ Menu bar
■ Top toolbar
■ Left toolbar
■ Settings area
■ Status bar
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Menu bar

The menu bar of the Océ Settings Editor contains the following menus:   

File   If you select the ‘File’ menu you can log on as a particular type of user, 
log off from the previously selected user mode, open an existing setting file, 
save the current settings to a file, connect to a different controller (only for 
remote users) or exit the Océ Settings Editor.

Edit  If you select ‘Options’ from the ‘Edit’ menu, a window is displayed in 
which you can view your default system and the display languages (first and 
second) for the Océ Settings Editor application. The ‘Automatic logon’ option 
allows you to start the Océ Settings Editor application automatically in the 
specified user mode.

View  The ‘View’ menu allows you to switch between the display languages as 
defined in the Edit options window and to switch between KO settings and SA 
settings.  

Help  The ‘Help’ menu contains the following options: ‘Contents of Océ 
Settings Editor’ and ‘About Océ Settings Editor’.

[15] Menu bar

Top toolbar

The top toolbar of the Océ Settings Editor contains four control buttons: 
‘Open’, ‘Save as’, ‘Apply’ and ‘Undo’.

[16] Top toolbar

Open  When you click on the ‘Open’ button, you open a saved file. 

Save as  All Key Operator and System Administrator settings can be saved in 
a file. This way you can have different settings for different customers, 
departments or other situations.
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Note: These settings can only be saved in Key Operator or System 
Administrator mode.

Apply  When you click on the ‘Apply’ button, the changes you have made 
become effective. Initially, this button is disabled. It is enabled after the first 
setting is changed and disabled again after the apply action is performed or 
after an undo action. 

Undo  This button restores the settings to the state it was in the last time the 
settings were applied (and not back to the factory default). Initially, the ‘Undo’ 
button is disabled. This button is enabled the moment the first setting is 
changed. It is disabled after an Apply action is performed or after an undo 
action

▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’, or press the ‘Save as’ button on the 
toolbar.
A dialog box is displayed and the user can supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that 
are currently visible. 

A few special files are available here:
■ Default.kos/Default.sas 

These files contain the factory default settings for the Key Operator and 
System Administrator, respectively, and cannot be changed.

■ Backup.kos/Backup.sas 
These files contain a previous version of the settings for the Key Operator 
and System Administrator, respectively (before the last Apply).

■ Current.kos/Current.sas 
These files contain the version of the settings for the Key Operator and 
System Administrator after the last Apply.

When an Apply is performed, first the contents of the current settings is copied 
to the backup file. There are two versions of this file, one for KO settings and 
one for SA settings. These files are always stored on the system.

▼ Open a saved file

1 Open the ‘File’ menu and select ‘Open’, or press the ‘Open’ button on the 
toolbar.
A dialog box is displayed from where you can choose the correct file.

2 Click the ‘Apply’ button. 
The loaded settings are transferred to the system.
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Note: This is only possible if the user is logged on as a Key Operator or System 
Administrator.

Left toolbar

There are four different buttons available at the left toolbar of the Océ Settings 
Editor. These are ‘Jobs’, ‘Printer’, ‘Scanner’ and ‘System’. Each button 
provides access to a specific group of settings. By clicking on each of these 
buttons, you can get access to the settings related to the selected group.

A shadow highlight is used to indicate which button is activated.

[17] Left toolbar

Settings area

The settings area consists of two parts: a setting tree and an update area.

Tree structure  Most settings are displayed using a tree structure. By clicking 
on the settings, folders can be opened to show all the entries or closed to hide 
all the entries below these folders.

The settings for system components that are not available are not displayed. 
So, if you do not have a scanner, no scanner settings are available. This means 
that different configurations result in different tree structures.

Note: When a tree item has been changed, this item will be marked with a 
bullet.
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Update area  The user can move through the tree and select a setting. If he 
selects a setting for which he is authorized, he can edit the setting in the update 
area.

If the user is not authorized for a particular setting, the update area is grayed 
and no changes can be made.

Note that a few settings, such as basic card and pen settings, are not edited from 
the tree structured, but are accessed directly from the settings area.

The update area contains some additional information about the selected  
setting. This includes a brief definition of the setting, as well as the minimum, 
maximum and default values (if appropriate).  

[18] Settings area
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Status bar

The Océ Settings Editor has a status bar displaying the following information 
(left to right):

■ System status (icon for connected or disconnected)
The following icons are used:  

The Océ Settings Editor is connected to a system. 

The Océ Settings Editor is not connected to a system.

■ System name
■ User mode (Repro operator, Key Operator, System Administrator or 

anonymous)
■ View mode (KO settings or SA settings).
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Use the Océ Settings Editor

The Océ Settings Editor enables you to change the default settings of the 
system. Only authorized users are allowed to change the default settings in the 
Océ Settings Editor.
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User modes

The following user modes are available:
■ Anonymous user mode
■ Repro operator mode
■ Key operator mode
■ System administrator mode
■ Service operator mode.

The anonymous user mode only offers monitoring capabilities. You are not 
allowed to change anything.

The repro operator, the key operator and the system administrator modes allow 
you to perform a number of user actions.

In the Settings Editor the user modes offer different rights. In repro operator 
mode, the operator is allowed to only view settings in the key operator and 
system administrator views. 

In key operator mode, the operator is allowed to view and change settings in 
the key operator view. The key operator is also allowed to view system 
administration settings, but is not able to change them.

In system administrator mode, the operator is allowed to view and change 
settings in the system administrator view. The system administrator is also 
allowed to view key operator settings, but is not able to change them. 

The service operator mode is meant for the Océ technician.

When you are not authorized to perform a certain action, the action is grayed 
out.

Only one Key Operator or System Administrator at a time is authorized to 
make modifications. However, there may be multiple users viewing the 
settings. When a second user tries to log on as Key Operator or as System 
Administrator, an error message is displayed.

Note: The status bar at the bottom displays the active user mode.
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Log on

The access to the key operator, repro operator, system administrator and 
service operator modes is password protected to allow only authorized 
personnel to use particular functions.

The default password for the System Administrator is: SysAdm.
The default password for the Key Operator is: KeyOp.
The default password for the Repro Operator is: ReproOp.
Note: The default passwords are case sensitive. Change the passwords after 
your first log on. 

▼ How to log on

1 From the ‘File’ menu, select ‘Log on’.
2 Select the correct user name.
3 Enter the Password. 
4 Click ‘OK’.

Note: You must log on into each application separately.

Log on is restricted to one user only. When a second user attempts to log on an 
error message will appear (see figure below).

[19] When a second user attempts to log on an error message will appear

Log off

You have to log off to leave the key operator, repro operator and system 
administrator modes.

▼ How to log off

1 From the ‘File’ menu, select ‘Log off’.
You return to anonymous user mode.
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To change the password

You can change your password on a standard base. You can change the 
password for each user mode (except anonymous user mode, for which no 
password is required and service operator) by taking the following steps:

▼ Change the password

1 From the ‘File’ menu, select ‘Log on’.
2 Click the ‘Password’ button. 
3 Select the correct username in the ‘Username’ drop-down list box.
4 Enter the old password in the ‘Password’ text box.
5 Enter the new password in the ‘New password’ text box.
6 Enter he new password in the ‘Confirm new password’ text box and click ‘OK’ 

to confirm the new password.

Automatic logon

If you do not want to log on each time you start an application, you can select 
the automatic logon function. This option allows you to start an application 
automatically in the indicated user mode.

▼ Enable automatic log on

1 From the ‘Edit’ menu, select ‘Options’.
The Options window appears.

2 Select the ‘Enable automatic logon’ check box.
3 Select the correct user mode and enter your password for that user mode.
4 Click ‘OK’. Automatic logon is now enabled.
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Language

From the ‘View’ menu, select ‘Language’, to select one of the supported 
languages. 

Note: The check mark in front of the language indicates that this is the active 
display language.

▼ Set the languages

1 From the ‘View’ menu, select ‘Language’.
You have to change the display language setting in the Settings Editor to 
change the languages in the scanner and printer operator panels.

Help

▼ Display help information

Open the ‘Help’ menu and select ‘Contents’. 

How to perform actions from the Océ Settings Editor

You can perform a number of activities from the Océ Settings Editor. These 
activities include:

■ Save settings to file
■ Load settings from a file
Save and load settings  All Key Operator and System Administrator settings 
can be saved in a file or loaded from a file. This way you can have different 
settings for different customers, departments or other situations.

Note: These settings can only be saved in Key Operator or System 
Administrator mode. 

▼ Save settings to file

1 Open the ‘File’ menu and select ‘Save as’.
You now have two possibilities:
a dialog box is displayed and the user can supply a directory and a file name.
Note: All settings in the current view mode are saved; not only the ones that 
are currently visible.  
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A few special files are available here:
■ Default.kos/Default.sas 

These files contain the factory default settings for the Key Operator and 
System Administrator, respectively, and cannot be changed.

■ Backup.kos/Backup.sas 
These files contain a previous version of the settings for the Key Operator 
and System Administrator, respectively (before the last Apply).

■ Current.kos/Current.sas 
These files contain the version of the settings for the Key Operator and 
System Administrator after the last Apply.

When an Apply is performed, first the contents of the current settings is copied 
to the backup file. There are two versions of this file, one for KO settings and 
one for SA settings. These files are always stored on the system.

▼ Load a settings file

1 Open the ‘File’ menu and select ‘Open’.
A dialog box is displayed from where you can choose the right file.

2 Click the ‘Apply’ button. 
The loaded settings are transferred to the system.
Note: This is only possible if the user is logged in as a Key Operator or System 
Administrator.
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Key Operator settings

The Key Operator is responsible for correct default settings of the system. 
These settings include the default settings, and groups of default printer 
settings for the print and the copy jobs that again occur.

The Key Operator can define all timer settings, like the panel time out and the 
sleep mode time out.

Note: One Key Operator or System Administrator can log on to the Océ 
Settings Editor at the same time.

In order to perform special Key Operator functions, you must log on to the Océ 
Settings Editor as a Key Operator.

As these functions are restricted to a dedicated Key Operator, a password is 
required to access them. The service engineer will provide this password to 
you upon installation.

Note: When you are finished, make certain you log off from the Key Operator 
mode of the Océ Settings Editor to prevent unauthorized use of the Océ 
TDS300.

▼ Make Key Operator settings in the Océ Settings Editor

1 maximize the Océ Settings Editor on the screen.
2 Log on as Key Operator.
3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings are made directly from the tree structure area.
6 Click on the ‘Apply’ button.

The new value is now applied for the setting
Log from the Key Operator mode when you have finished updating the 
settings.
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System Administrator settings

The Océ TDS300 System Administrator is responsible for: 

■ Poker settings
■ Printer language controller settings
■ Pen settings
■ Page Description Language (PDL) settings
■ Controller identification settings
■ Set memory reservation settings
■ Connectivity settings. 

To modify the System Administrator settings you have to access the SA 
settings in the Océ Settings Editor.

There are two types of System Administrator settings (see figure 20):

■ Printer
■ System

.

[20] System Administrator settings in the Océ Settings Editor

In order to perform special System Administrator functions, you must log on 
to the Océ Settings Editor as a System Administrator (see ‘User modes’ on 
page 79).

Note: When you are finished, make certain you log off from the System 
Administrator mode of the Océ Settings Editor to prevent unauthorized use of 
the Océ TDS300.
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▼ Make System Administrator settings in the Océ Settings Editor

1 Maximize the Océ Settings Editor on the screen.
2 Log on as System Administrator. 

See ‘User modes’ on page 79 for more information about logging on to the Océ 
Settings Editor.

3 Click on one of the top buttons to display the desired group of settings.
4 Select the setting you want to update in the tree structure.
5 Update the setting in the update area, as required.

Note: A few settings, such as the default pen settings, are made directly 
from the tree structure area.

6 Click on the ‘Apply’ button.
The new value is now applied for the setting

7 Log off from the System Administrator mode when you are finished updating 
settings.
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Océ TDS300

User Manual
Chapter 6
Printer supplies and maintenance

This chapter describes how to:
■ Load media
■ Refill toner and replace the waste toner bag
■ Clean the glass platen and the reference roller of the scanner
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Media

The Océ TDS300 is available with a roll unit for one or two rolls. 

Each of the rolls on the Océ TDS300 can be loaded with print material of a 
different size or type. The size and type of the available media are indicated on 
the operator panel.

Attention: When you load new print material, you must tell the system the 
size of the material and the type of print material (paper, transparent, or 
polyester). Refer to ‘Media type and size on the printer’ on page 23.

The definition of the size and type of the new print material is required to:
■ Enable the automatic media switch function to work correctly.
■ Support auto format functions.

The paper rolls

When a roll is empty during a print job, a ‘Roll empty’ message is displayed 
at the printer operator panel and on the Océ System Control Panel application. 
You then have to load a new roll of print material.

Note: You can use the following media for the Océ TDS300:

■ Plain paper  64 g/m2 (55 g/m2)
■ Plain paper  75 g/m2 (110 g/m2)
■ Biotop paper 80 g/m2
■ Green label 80 g/m2
■ Transparent paper 75 g/m2
■ Transparent paper 90/95 g/m2 (80/85 g/m2)
■ Transparent paper 110/115 g/m2
■ Translucent 60 g/m2
■ Vellum 20 lbs (16 lbs)
■ Film 3.5 mil (4 mil)
■ Film 4.5 mil
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Reload paper

▼ How to load roll 1

1 Open the drawer completely (see figure 21).

[21] Open the  drawer

2 Remove the roll holder from the drawer (see figure 22).

[22] Removing the roll holder from the drawer

3 Remove the empty core from the roll holder while pressing the knob (see 
figure 23).

4 Slide the roll holder in the new roll of material while pressing the knob (see 
figure 23). The knob must be at the right hand side and paper must be 
positioned as shown in figure 23.
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[23] Press the knob

5 Align the roll with the appropriate lines on the roll holder while pressing the 
knob. This line has to be completely visible.

6 Place the roll holder with the material in the drawer (see figure 24).

[24] Reposition the roll

7 Feed the material between the input guide plates against the rollers.
8 Turn the rollers until the material is visible (see figure 25). Also refer to the 

sticker inside the drawer.

34"
A0 36"
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[25] Feed the material

9 If you have inserted a roll with another material or with a different width, you 
have to program the correct width and material type (refer to ‘Media type and 
size on the printer’ on page 23).
If you want to cut the paper to get a straight leading strip refer to ‘Cut media’ 
on page 25.
Otherwise continue with the next step.

10 Close the drawer.
11 Press the On-line key.

▼ How to load roll 2

1 Open the cover to get access to roll 2 (see figure 26).

[26] Open the lower paper drawer

2 Remove the roll holder (see figure 27).
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[27] Remove the roll holder from the lower paper drawer

3 Remove the empty core from the roll holder while pressing the knob (see 
figure 23 on page 90).

4 Slide the roll holder in the roll of print material while pressing the knob (see 
figure 23 on page 90). 
It is important to have the knob at the right hand side and the paper as shown 
in figure 23.

5 Align the roll with the appropriate lines on the roll holder while you press the 
knob.
Place the roll holder with the material in the lower paper compartment (see 
figure 28).

da

[28] Reposition the roll in the lower paper drawer

6 Feed the material between the input guide plates against the rollers. Turn the 
rollers until the material is visible (see figure 29). Also refer to the sticker 
inside the drawer.
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[29] Feed the material

If you want to cut the paper to get a straight leading strip refer to ‘Cut media’ 
on page 25.
Otherwise continue with the next step.

7 Close the lower paper compartment.
8 Press the On-line key.

How to program media settings

If you insert a new roll with another material or with a different width, set the 
new roll specifications.

The width of the material
Material Size
A0 841 mm
A1 594 mm
A2 420 mm
A3 297 mm
E 86.36 cm
D 55.88 cm
C 43.18 cm
B 27.94 cm
E+ 91.44 cm
D+ 60.96 cm
C+ 45.72 cm
B+ 30.48 cm
76.20 cm 76.20 cm
B1+ 700 mm
B2+ 500 mm
Note: The default is 36 inch
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The material  paper, transparent, transparent 110g, vellum, film, film 4,5, 
translucent. Set the material type according to the following table:

Material properties
Material Weight Media Setting
Plain paper 64 g/m2(55 g/m2) Paper 64g
Plain paper 75 g/m2(110 g/m2) Paper
Biotop paper 80 g/m2 Paper 75g
Green label 80 g/m2 Paper 75g
Transparent paper 75 g/m2 Transparent 75g
Transparent paper 90/95 g/m2 (80/85 g/m2) Transparent 75g
Transparent paper 110/115 g/m2 Transparent 110 g
Translucent 60 g/m2 Translucent
Vellum 20 lbs (16 lbs) Vellum
Film 3.5 mil (4 mil) Film
Film 4.5 mil Film 4.5
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How to refill toner

If the ‘Refill toner’ message appears on the printer panel, you must refill toner 
immediately. 

Attention: Use only B5 toner.

▼ Refill toner

1 Turn off the printer.
2 Unscrew the knurled nut at the left hand side of the printer and open the left 

cover (see figure 30).

[30] Unscrew the knurled nut and open the cover

3 Shake the toner bottle thoroughly and open the bottle.
4 Screw in the bottle clockwise in a slanted position (see figure 31).
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[31] Screw in the bottle

5 Move the toner bottle to a vertical position (see figure 32).

[32] Add toner

6 Tap the toner out of the bottle.
7 When the toner bottle is empty return the bottle to the original position.
8 Unscrew the toner bottle anti clockwise.

▼ Replace the waste toner bag

9 Pull the waste toner bag from the holder and place the cap provided on the bag 
(see figure 33).

B5

B5
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[33] Replace the waste toner bag

10 Slide a new waste toner bag over the holder.
11 Close the cover and tighten the knurled nut.
12 Press the On-line key to resume printing. 

Note: Replace the toner waste bag, every time you refill the toner.
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Clean the glass platen and the reference 
roller of the scanner

If the glass platen of the scanner is dirty or static, it should be cleaned to ensure 
top quality copies are produced. At the same time you can clean the white 
reference roller.

Attention: When you clean the reference roller, be careful not to damage the 
sensors on the scanner

▼ How to clean the glass platen and reference roller

1 Switch off the scanner.
2 Unlock the top cover by pushing the front side of the cover down and pulling 

it towards.

[34] Open the top cover of the scanner

3 Raise the cover (see figure 35 on page 99). 
4 Clean the glass platen and the white pressure platen gently with a soft cloth 

moistened with a small quantity “Cleaner A”. 
For safety information see the safety data sheet in Appendix B.
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[35] Glass platen and reference roller

5 Lower the top cover.
6 Lock the cover by pushing the front side of the cover down and pushing it back 

to the rear until you hear a click.
Note: Make sure that the cover is closed correctly, to ensure proper original 
transport.

7 Switch on the scanner.
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The Océ TDS300 

[36] The Océ TDS300 system

1 Printer operating panel
2 Printer
3 Manual feed
4 Integrated Receiving Tray
5 Rolls
6 Scanner
7 Scanner feed table
8 Scanner operating panel.

1
3 2

4

5

6

7

8 9
102 Océ TDS300 User Manual



Printer operator panel

nästa/välj

föregående

on-line stopp

1

2

3

56

4

1 The graphics display
2 The Previous key
3 The Next/select key
4 The Stop key
5 The Browse keys (left , 

right )
6 The On-line key
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Scanner operator panel

Alphanumeric 
display

Browse keys

Confirm
key

Strip key

Copy quantity 
display

Cancel key

+ key

Zoom key

Exposure key

- key

Start key

Media key

Extra keyOutput keyInput key

+-starta avbryt

kantexponering

inmatning utmatning extra

uppsättning fil

zooma

ark kopiering

superior

inferior

rulle 1

rulle 2

manuell

material
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Product specifications Océ TDS300

The Océ TDS300 is a wide format low to medium volume print and copy 
system.

Printer
Technology Electrophotography (LED) with organic photoconductor 

(OPC) drum and closed toner system
Resolution 600 dpi
Speed 3 linear meters p/min.
Productivity 1.8 A0s p/min.
Media sources 1-roll version with manual feed

2-roll version with manual feed
2-roll version with manual feed

Output sizes From A3 to A0 and 36”, a maximum of 15 meters long
Media types Plain, translucent, transparent, recycled, fluorescent and 

colored papers; films and vellum
Output reception Standard Integrated Receiving Tray (IRT)
Warm up time None, instant behavior
Dimensions 1352 mm (W) x 1250 mm (H) x 899mm (D) including 

integrated receiving tray
Weight Model with 1 roll 149 kg

Model with 2 rolls 159 kg
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Océ Power Logic® Controller
Platform Océ Controller with embedded Windows XP®

Memory 256 MByte RAM standard, extendible to 1024 MByte
Disk space High-speed hard disk dedicated to file spooling, and a 

high-speed hard disk dedicated to set memory offering 
14 A0 storage capacity per GB hard disk.

File formats HPGL, HPGL2, HPRTL, TIFF 6.0, CALS type 1, NIRS, 
EDMICS (C4), CalComp 906/907/951, ASCII, Adobe® 
PostScript® 3™

Interfaces Standard: Ethernet 10/100 Mb with RJ45
Optional: Ethernet 10 Mb with BNC and SubD; Token 
Ring 4/16 Mb

Network protocols TCP/IP, Novell (IPX, SPX), FTP, LPD
Adobe® Postscript® 
3™ / PDF

Enables you to print the Postscript® level 3™ files and 
Portable Document Files (PDF), optional.

Functionality Multiple prints: up to 999
Automatic Language Sensing (ALS)
Auto roll selection and switching
Plot manipulation: rotation, auto scaling
File spooling on the controller
Set memory: send once, process once, print many; ca-
pacity to store up to 14 A0 per GB hard disk. and create 
identical sets sorted by page or by set.
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Océ Remote Logic® software
Software Application Functionality
Océ Settings Editor Change the default settings of the system

Scanner
Model Free-standing console
Technology CCD, Océ Image Logic® real-time image processing hard-

ware
Speed 3 linear meters per minute.
Productivity 1.8 A0s per minute

Original feed Face down, right aligned
Automatic feed off/on
Rewind original to front off/on

Originals A4 to A0 sizes and 36”, up to 15 meters.
Maximum thickness 1 mm
Exposure control Automatic background compensation, manual fine adjust-

ment.
Special modes: Lines & Text, Photo, Blueprint

Media selection Manual selection of roll 1 or 2 or manual feed.
Input mode Single sheet

Set (sets processing/set collation)
Functionality Multi-copy mode: 1-99 copies (scan once, print many)

Pre-programming of next job
Programmable default settings
Standard cut, synchro cut
Leading and trailing strip adjustment (remove 400 mm, add 
400 mm)

Image editing Image mirroring
Dimensions 1240 mm (W) x 1105 mm (H) x 615 mm (D)
Weight 65 Kg

Drivers and application software
Océ HDI driver For AutoCAD® 2000® and above
Océ Windows Raster 
driver

Microsoft® Windows® 95/98

Océ Windows Printer 
driver

Microsoft® Windows® 2000®, XP, and NT 4.0®

Adobe® PostScript® 
Level 3™ 
drivers

Microsoft® Windows® 95/98/2000®, XP, NT 4.0® and 
Apple® Mac®

Note: Check Océ on the internet at www.oce.com for the latest drivers.
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Finishing: output delivery tray (Optional)
Model Wheeled delivery tray with blower unit
Capacity Up to 150 sheets (media type dependent) from A3 to A0
Types of media Plain paper, transparent paper, film, vellum, polyester and 

translucent
Dimensions 1170 mm (W) x 1090 mm (H) x 1440 mm (D) with tray ful-

ly extended
Weight 35.5 kg
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List of available material types and sizes

Océ machines and materials are matched for optimal quality and performance. 
It is therefore recommended to use only approved Océ materials in the Océ 
TDS300.
A full list of Océ materials suited for use in the Océ TDS300, including plain 
paper, transparent paper, colored papers and various polyester films is 
available from your Océ representative.

Material types

The following material types are available for the Océ TDS300:

The following material sizes are available for the Océ TDS300:

Material Types
Materials Weight
Plain paper 64 g/m2(55g/m2)
Plain paper 75 g/m2(110g/m2)
Plain paper 80 g/m2

Biotop paper 80 g/m2

Green Label 80 g/m2

Translucent paper 75 g/m2

Transparent paper 90/95 g/m2 

(80/85g/m2)
Transparent paper 110/115 g/m2

Transparent paper 20 lbs (16 lbs)
Top label paper 60 g/m2

Vellum 3.5 mil (4 mil)
Film 4.5 mil
Polyester film 3.5 or 4.5 mil
Special colored paper, etc.

Minimum Maximum
Width 297 mm 914 mm
Length 420 mm 15 m

DIN range
Material Width [mm] Length [mm]
A3 297 420
A2 420 594
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500 

Attention: Avoid storing paper in rooms where temperature and humidity 
are high. Also, avoid dust and direct sunlight. Wrap unused paper in plastic 
to prevent it absorbing moisture.

A1 594 841
A0 841 1189

8,5 inch range
Material Width [inch] Length [inch]
11 inch / B 11 17
17 inch / C 17 22
22 inch / D 22 34
34 inch / E 34 44

22.86 cm range
Material Width [inch] Length [inch]
12 inch / B+ 12 18
18 inch / C+ 18 24
24 inch / D+ 24 36
36 inch / E+ 36 48

Other formats
Material Width Length
76.20 cm 76.20 cm 30.48 cm
B1+ 700 mm 1,000 mm
B1 (DIN) 707 mm 1,000 mm
B2+ 500 mm 700 mm
B2 (DIN) 500 mm 707 mm

DIN range
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Automatic format selection

The Océ TDS300 controller switches to the next larger format. For example 
you set the 8,5 inch range on the printer. The job you print is an A1 format. The 
printer will automatically select the 30-inch format. The next table shows 
which format the Océ TDS300 controller chooses if you print a specific format 
on a chosen range

.

Automatic format selection
Paper series
DIN DIN carto 21.59 cm Mixed 8,5 and 9,5 inch

DIN range
A3 X X
A2 X X
A1 X X
A0 X X
8,5 inch range
11 inch / B X X
17 inch / C X X
22 inch / D X X
34 inch / E X X
22.86 cm range
12 inch / B+ X
18 inch / C+ X
24 inch / D+ X X
36 inch / E+ X X X X
Other formats
76.20 cm X X
B1 carto X
B1 (DIN) X
B2 carto X
B2 (DIN) X
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Summary of standard zoom formats

Standard zoom fixed steps for the DIN paper series [%]
Original A0 A1 A2 A3 91.44 cm B1 B2
A0 100 71 50 35 109 84 59
A1 141 100 71 50 153 119 84
A2 200 141 100 71 218 168 119
A3 283 200 141 100 308 238 168
91.44 cm 107 65 46 32 100 77 55
B1 119 84 59 42 129 100 71
B2 168 119 84 59 183 141 100

Standard zoom fixed steps for the DIN carto paper 
series [%]
Original A0 A1 A2 A3 91.44 cm B1 B2
A0 100 71 50 35 109 83 59
A1 141 100 71 50 153 118 84
A2 200 141 100 71 218 167 119
A3 283 200 141 100 308 236 168
91.44 cm 107 65 46 32 100 77 55
B1 120 85 60 42 130 100 71
B2 168 119 84 59 183 140 100

Standard zoom fixed steps for the 8,5 inch paper series 
[%]
Original 
[inch]

11 / B 17 / C 22 / D 24 / D+ 30 34 / E 36 / E+

11 / B 100 154 200 218 273 309 327
17 / C 65 100 129 141 176 200 212
22 / D 50 77 100 109 136 155 164
24 / D+ 46 71 92 100 125 142 150
30 37 57 73 80 100 113 120
34 / E 32 50 65 71 88 100 106
36 / E+ 31 47 61 67 83 94 100
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Standard zoom fixed steps for the 8,5 & 9 inch mixed 
paper series [%]
Original 
[inch]

11 / B 12 / 
B+

17 / 
C

18 / 
C+

22 / 
D

24 / 
D+

30 34 / 
E

36 / E+

11 / B 100 109 154 164 200 218 273 309 327
12 / B+ 92 100 142 150 183 200 250 283 300
17 / C 65 71 100 106 129 141 176 200 212
18 / C+ 61 67 94 100 122 133 167 189 200
22 / D 50 55 77 82 100 109 136 155 164
24 / D+ 46 50 71 75 92 100 125 142 150
30 37 40 57 60 73 80 100 113 120
34 / E 32 35 50 53 65 71 88 100 106
36 / E+ 31 33 47 50 61 67 83 94 100
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General safety information

For questions about Océ products which are related to health, safety and the 
environment, please contact your Océ organization at the address listed in the 
last appendix of this manual.

Radio interference

Note: This equipment has been tested and found to comply with the limits for a 
class A device, pursuant to part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the user manual, may cause harmful interference 
to radio communications. Operation of this equipment in a residential area is 
likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

FCC = Federal Communications Commission.

Symbols

Stickers with the following illustrations are used in this machine to indicate 
parts which should not be touched due to high voltage or extreme heat, or parts 
which require extra attention:

Symbol Meaning

Caution, high voltage

Caution, high temperature

Caution
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Instructions for safe use

Attention: Products designed by Océ are developed and tested in 
conformance with the strictest international safety standards. However, to 
help assure the safe operation of these products, it is important that:

■ You carry out maintenance only as far as prescribed in this manual.
■ You observe the following safety recommendations:

Maintenance  

■ Do not remove any screws from fixed panels.
■ Do not place any liquids on the machine.
■ Use maintenance materials or other materials for their original purpose only. 

Keep maintenance materials away from children.
■ To avoid damage and the risk of personal injury, all modifications to Océ 

equipment are strictly reserved for properly qualified and trained service 
technicians.

Power connection  

■ If unforeseen circumstances force you to re-install the machine without the 
assistance of Océ Service, make sure that the machine is connected to a 
power outlet which is equipped with a fuse or circuit breaker with the 
appropriate capacity.

■ Do not bridge any mechanical or electrical circuit breakers.
■ Do not use an extension cord to connect the machine.
■ This equipment is not designed for connection to an IT power system. (An 

IT power system is a voltage network in which the neutral wire is not 
connected to earth.)

■ For equipment connected via a wall outlet: place the machine close to an 
easily accessible wall outlet.

■ For equipment connected to the electrical system via a permanent 
connection: make sure that the disconnect device in the permanent 
connection is easily accessible.
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Ventilation and location  

■ Do not block the ventilation openings of the machine.
■ Make sure that the machine is placed on a level, horizontal surface which is 

strong enough to bear the full weight of the machine. See the Océ TDS300 
safety data sheet in this appendix for information about the weight of the 
machine. 

■ Make sure that there is sufficient space around the machine. This facilitates 
both proper loading of materials and equipment maintenance.

■ Do not place the machine in a room which is subject to excessive vibration.
■ Do not place the machine in a room that is too small and insufficiently 

ventilated. See the Océ TDS300 safety data sheet in this appendix for 
information about space and ventilation requirements.

General  

■ Always use materials recommended by Océ and developed for this Océ 
machine. Materials not approved by Océ may cause damage to your 
machine.

■ Do not use the machine if it is making unusual sounds. Remove the plug from 
the power outlet or turn off the switch in the fixed connection to the electrical 
system and contact Service.
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Safety data sheet for the Océ TDS300

Disclaimer  This safety data sheet was compiled as a compact guide to safe 
product handling and operation, and to the best of our knowledge contains the 
most complete and accurate information possible. We reserve the right to 
revise this safety data sheet as new information becomes available. It is the 
user’s responsibility to determine the suitability of this information for the 
adoption of the appropriate safety precautions for his organization, and to 
contact Océ to make sure that he is in possession of the latest version of the 
sheet. If and insofar as limitation of liability is permitted under the applicable 
laws, we accept no liability for any inaccuracies in this safety data sheet.
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Safety data sheet Océ TDS300 printer

The content of this safety data sheet is subject to the disclaimer of liability on page 119 of this manual.
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Safety data sheet Océ TDS300 printer and scanner

The content of this safety data sheet is subject to the disclaimer of liability on page 119 of this manual.
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EPA ENERGY STAR®

Océ-Technologies B.V. has joined the ENERGY STAR® Program of the United 
States Environmental Protection Agency (EPA). The purpose of the ENERGY 
STAR® Program is to promote the manufacturing and marketing of 
energy-efficient equipment in order to reduce combustion-related pollution.

As an ENERGY STAR® Partner, Océ-Technologies B.V. has determined that this 
copier meets the ENERGY STAR® guidelines for energy efficiency.

The EPA ENERGY STAR® Criteria for copiers have the following features:

low-power mode  In the low-power mode, the power consumption of certain 
functions is automatically reduced to save energy. The copier enters low power 
mode 30 minutes after the last copy is made1. This default time can be adjusted 
by the key operator to between 5 and 120 minutes. The low power mode 
recovery time is less than 1 seconds, after which copying can be resumed.

recycled paper  The use of recycled paper also benefits the environment. This 
copier is designed to use recycled copier paper. Product literature about 
recommended types of recycled copier paper can be obtained from your local 
Océ organization, or from Océ Headquarters (Océ-Technologies B.V.) in 
Venlo, the Netherlands.

1For power consumption data: see the Product Safety Data Sheet in this 
appendix.

 

ENERGY STAR® is a U.S. registered mark.
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How to read this manual

The consistent style that is used in this manual enables you to quickly become 
familiar with the use of this manual and ultimately the Océ TDS300.

Description  Each section or subsection contains a description of the feature or 
operation identified in the title. It might also include possible applications, as 
well as any guidelines that you should bear in mind.

Procedures  A description is followed by a procedure. A procedure always 
begins with a phrase which briefly describes the procedure, followed by a 
series of numbered steps that take you, step by step, through all phases of 
performing the operation. 

Figures and tables  Figures and tables are titled and numbered sequentially 
throughout this manual. Figures include pictures of product components, 
screen dumps, examples, and diagrams of concepts discussed in the 
description.

Attention getters  There are several types of information to which we draw 
your attention. This information is classified as follows:

Note: In a ‘Note’, information is given about matters which ensure the proper 
functioning of the machine or application, but useful advice concerning its 
operation may also be given.

Attention: The information that follows ‘Attention’ is given to avoid 
damage to your copy or original, the copier or printer, data files, etc.

Caution: The information that follows ‘Caution’ is given to prevent you 
suffering personal injury. .
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User survey

Did you find this manual to be accurate?
❏ Yes
❏ No

Were you able to operate the product after reading this manual?
❏ Yes
❏ No

Does this manual provide adequate background information?
❏ Yes
❏ No

Is the format of this manual convenient in size, easy to read and layed out well?
❏ Yes
❏ No

Did you find the information you were looking for?
❏ Always
❏ Most of the times
❏ Sometimes
❏ Not at all

How did you find the information you were looking for?
❏ Table of contents
❏ Index
❏ Neither

Are you satisfied with this manual?
❏ Yes
❏ No

Thank you for evaluating this manual. 
If you have any other comments or concerns, please explain them on the 
following page.
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Comments:

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------
Date:

This reader’s comment sheet is completed by: 

Name (optional):

Occupation:

Company:

Phone:

Address:

City:

Country:

Please return this sheet to:

Océ-Technologies B.V.
Attn: ITC-User Documentation
P.O. Box 101
5900 MA Venlo
The Netherlands

Send you comments by E-mail to: itc-userdoc@oce.nl

For the addresses of local Océ organizations see: www.oce.com
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Addresses of local Océ organizations
Océ-Australia Ltd.
P.O.Box 363
Ferntree Gully MDC VIC 3165
Australia

Océ-Österreich GmbH
Postfach 95
1233 Vienna
Austria

Océ-Belgium N.V./S.A.
Avenue J.Bordetlaan 32
1140 Brussels 
Belgium

Océ-Brasil Comércio e Industria Ltda.
Caixa Postal 3187
01060-970 Sao Paulo, SP
Brazil

Océ-Canada Inc.
4711 Yonge Street, Suite 1100
Toronto, Ontario M2N 6K8
Canada

Océ Office Equipment (Beijing) Co Ltd.
Xu Mu Cheng
Chaoyang District
Beijing 100028
China

Océ-Česká republika s.r.o.
Hanusova 18
14021 Praha 4
Pankrác,
Czech Republic
Miscellaneous
Océ-Danmark A.S.
Vallensbaekvej 45
DK 2605 Brøndby
Denmark

Océ-France S.A.
32, Avenue du Pavé Neuf,
93161 Noisy-le-grand, Cedex
France

Océ-Deutschland GmbH
Postfach 101454
4330 Mülheim an der Ruhr (13)
Deutschland

Océ (Hong Kong China) Ltd.
12/F 1202 The Lee Gardens
33 Hysan Avenue, Causeway Bay
Hong Kong

Océ-Hungária Kft.
P.O.B. 237
1241 Budapest
Hungary

Océ-Italia S.p.A.
Strada Padana Superiore 2/B
20063 Cernusco sul Naviglio (MI)
Italia

Océ Systems (Malaysia Sdn. Bhd.)
#3.01, Level 3, Wisma Academy
Lot 4A, Jalan 19/1
46300 Petalig Jaya
Malaysia
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Océ-Nederland B.V.
P.O.Box 800
5201 AV ‘s-Hertogenbosch
The Netherlands

Océ Norge A/S
Postboks 53, Grefsen
0409 Oslo 4
Norway

Océ-Poland Ltd.
ul. Łopuszańska 53
02-232 Warszawa
Poland

Océ-Lima Mayer S.A.
Av. José Gomes Ferreira, 11
Ed. Atlas II Miraflores
1495 Algés
Portugal

Océ (Far East) Pte. Ltd./
Océ (Singapore) Pte. Ltd.,
#03-00 Wisma Gulab
190 MacPherson Road
Singapore 348548

Océ España SA
Business Park MAS BLAU
C/Osona 2, 2-3a Planta
08820 El Prat del Llobregat (Barcelona)
Spain

Océ-Svenska AB
P.O.box 1231
S-164 28 Kista
Sweden

Océ-Schweiz AG
Sägereistrasse 29
CH8152 Glattbrugg
Switzerland
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Océ (Taiwan) Ltd.
No. 99-24 Nan Kang Road Sec.2
Taipeh, Taiwan
Taiwan, RO

Océ (Thailand) Ltd.
16th Floor, B.B. Building
54 Asoke Road, Sukhumvit 21
Bangkok 10110
Thailand

Océ-U.K.Ltd.
Langston Road
Loughton, Essex IG10 3SL
United Kingdom

Océ-USA Inc.
5450 North Cumberland Av.
Chicago, Ill. 60656
U.S.A.

Océ-Japan Corporation
25-1, Nishi-Shinbashi 3-Chome
Minato-ku, Tokyo 105-0003
Japan



Index

A
add a controller 70
add toner 95

replace waste toner bag 95
alphanumeric display 20
applications 58
apply 74
Automatic format selection 111
Automatic logon 81
available material types and sizes 109

C
cancel key 52
cleaner A 98
Clear set memory 32
command line parameters 64
configuration report 27
connect to a controller 70
Connecting 70
Controller

start up 17
copy process

start 43
cut media 25

D
demo print 27
Diagnostic mode 32
display (printer)

Error messages 34
Status messages 33

Display language 82
Drivers 107

G
general control buttons 77

H
help 82

I
install remote logic 59
IP address. 29

K
key operator settings 71
keys 21

selection keys 21
stop 21

L
language 82
load media 88
Log off 80
Log on 80

M
maintenance

glass platen 98
reference roller 98

manual feed 9, 49
Material

types 109
Material properties 94
menu bar 73
menu level indicator 20, 41
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N
network settings 29

default gateway 29
DHCP server 29
IP address 29
subnet mask 29

O
Océ Remote Logic

User modes 79
Océ TDS300 system 8
on/off switch printer 16
optional

Automatic 2-roll unit 10
original guide line 44
output delivery tray 108

P
paper series 32

8.5 inch 32
DIN 32
DIN CARTO 32
mix 8.5/9 inch 32

password 81
Power Logic Controller 10
pre-cut copy material 49
print

configuration report 27
demo print 28
menu card printer 27

printer 9
printer keys 21
printer menu 27
printer settings

selecting language 29
set a special media indication 23
stopping print job 29

product specifications 105
Drivers and application software 107
Power Logic controller 106
Printer 105
Remote Logic software 107

program media settings 93

R
refill toner 95
Remote Logic

languages 82
repro operator settings 12

S
Safety data sheets

Océ TDS400 printer 120
Océ TDS400 printer and scanner 121

safety information 117
Scan jobs

Leading and trailing strip 54
scanner display 40
scanner feed table 44
scanner operating panel

keys 39
select language 29
selection keys 21
set

default gateway 31
IP address 30
language 29
media type 24
media width 24
paper series 32
Subnet mask 31
time-out manual feed 25
use DHCP server 30

Set default gateway 29
set media type and size 23
set memory 32
setting dependencies 71
settings area 75
Settings Editor 10
standard cut 42
standard zoom formats 112
status bar 77
stop a copy job 52
stop key 21
Subnet mask 29
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synchro cut 42
system administrator settings 71
System menu 29

enter 30

T
time-out manual feed 25
top cover of the scanner 98
tree structure 75
turn off

printer 16
turn off the printer 16, 22
turn on

printer 16
turn on the printer 16, 22

U
undo 74
Unix 61
update area 76
Use DHCP server 29
User modes 79

W
waste toner bag 95, 96
width of the material 93
work on a remote system 70
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